PI: Lynne O’Connell

Chemistry Science Education Title: Using Freezing-Point Depression to Determine the Identity of an Unknown Compound

Overview:	Comment by Andrew Wilkens: The Overview should include the background and significance of the topic. In this case, include a brief introduction to freeze-point depression, and the fact that it can be used for a few key uses. You might be able to move some of the content from the Principles to here.

When a solid compound is dissolved in a solvent, the freezing point of the resulting solution is lower than that of the pure solvent. This phenomenon is known as freezing-point depression, and the change in temperature is directly related to the molecular weight of the solute. This experiment is designed to find the identity of an unknown compound by using the phenomenon of freezing-point depression to determine its molecular weight. The compound will be dissolved in cyclohexane, and the freezing point of this solution, as well as that of pure cyclohexane, will be measured. The difference between these two temperatures allows for the calculation of the molecular weight of the unknown substance.
This experiment is designed to find the identity of an unknown compound by determining its molecular weight. The compound is dissolved in cyclohexane, and then the freezing point of this solution is measured. The freezing point of the solution is lower than that of pure cyclohexane, and this temperature difference is used to calculate the molecular weight of the unknown compound. 

Principles:

Certain properties of a solution differ from those of a pure solvent due to interactions that take place between the solute and solvent molecules. The properties that exhibit such changes are called the colligative properties, which and include vapor-pressure lowering, boiling-point elevation, freezing-point depression, and changes in osmotic pressure. These properties are dependent only upon the number of particles dissolved in the solvent, not on the identity of the particles. A particle, in this instance, is defined as an ion or a molecule. This experiment focuses on the phenomenon property of freezing-point depression.
	
When a particular solute is dissolved in a solvent, the following expression holds true:

T = Tf° – Tf = Kfm

The terms Tf° and Tf refer to the freezing-point temperatures of the pure solvent and the solution, respectively. The term “m” indicates the molality of the solution, which is defined as the number of moles of solute per 1,000 g of solvent. This quantity is used, rather than molarity, because it is not temperature dependent. The constant, Kf, is referred to as the freezing-point-depression constant and is dependent only upon the solvent. The change in temperature is also dependent upon the number of solute particles in solution — the more particles present, the larger the change in temperature.

For this reason, the previous equation is sometimes written as: 

Tf° - Tf = Kfim

where i = the number of solute particles produced per formula unit that dissolves. In a solution containing an electrolyte, each ion is considered to be a particle.  
	
This experiment uses cyclohexane, an organic compound that is a liquid at room temperature, as the solvent. The unknown compound is a non-ionic organic molecule; therefore, i is equal to 1. The molecular weight of this unknown compound can be determined by observing the freezing point of a solution of the compound in cyclohexane and comparing it to the freezing point of pure cyclohexane.  

The compound cyclohexane has a melting point (or freezing point) of about 6 °C. A series of temperatures of pure cyclohexane are obtained as it cools down from room temperature through its freezing point in an ice bath. These temperatures are then plotted as a function of time. Similarly, temperatures of a solution of the unknown compound dissolved in cyclohexane are obtained as it cools down to the freezing point, which are also plotted. The plots should look similar to the plots in Figure 1. The Tf° and Tf values can be extrapolated, as shown. In Figure 1b, the temperature does not remain entirely constant as the solution freezes. The freezing point of the solution is the point at which it first begins to freeze and is indicated graphically by a change in the slope of the temperature-time curve.	Comment by Andrew Wilkens: We’d like you to generate cleaner versions of these plots on the day of filming. Ideally, we’d like you to use screen capture software to record the process directly on the computer (assuming that’s how you’ll capture it). Is that possible? 	Comment by Dennis McGonagle: Author said it was

The molality, m, of a solution can be expressed in terms of the molar mass of the solute:  




[bookmark: _GoBack]





Substituting this expression into the equation for freezing-point depression (where i = 1), obtains:
	
Rearranging to solve for molar mass, obtains:  




The molecular weight (in amu) of a substance has the same numerical value as its molar mass. 

The unknown substance is one of the following compounds:

· Biphenyl (C12H10)
· 2-Bromochlorobenzene (C6H4BrCl)
· Naphthalene (C10H8)
· Anthracene (C14H10)
· 1,4-Dibromobenzene (C6H4Br2)


Procedure:

A temperature probe interfaced to a computer is used to acquire the temperature readings in this experiment. The temperature probe has an uncertainty of ±0.1 °C.

1. Setting the Pparameters in the SLogger Pro software.

1.1. [bookmark: OLE_LINK1][bookmark: OLE_LINK2]Pull down the Experiment menu and choose Data Collection.Set the length of the experiment to 800 s.  

1.2. Change the length of the experiment to 800 sec. The Set the sSampling rRate should be set to 1 sample per second.s/sec. Click on Done. 

1.3. Click once on the number at the very top ofSet the upper limit for the temperature range to 40 °C and the lower limit to 0 °C. the y-axis. Type in 40 and press enter.  	Comment by Andrew Wilkens: Steps like this are very software dependent. In the name of making the procedure as general as possible, change all similar steps to, for example, “Change the y-axis to 40”.

2. Measuring the fFreezing Ppoint of Ccyclohexane.

2.1. Dispense 12.0 mL of cyclohexane from the dispensing bottle into a 16 x 150 mm test tube that is clean and dry. Caution: Ccyclohexane is a flammable solvent.  

2.2. Wipe the temperature probe with a paper towelKimwipe to be sure it is dry.	Comment by Andrew Wilkens: Can you use a Kimwipe, or some other lab tissue? Is this necessary? 

2.3. Insert the stopper with the temperature probe and wire stirrer into the test tube.  

2.4. Make sure the tip of the temperature probe is in the center of the liquid and not touching the sides or bottom of the test tube.

2.5. Fill a 600- mL beaker about one-third full of water, and add ice until the beaker is three-fourths full.

2.6. Click on the green arrow button. This activates the computer’sStart the data collection. The computer acquires a  of the temperature reading every second.s.	Comment by Andrew Wilkens: See comment for 1.3.

2.7. Move the test tube into the ice-water bath and hold it so the level of liquid in the test tube is below the level of water in the bath.  

2.8. Immediately begin stirring the liquid with the wire stirrer, continuously and at a constant rate.

2.9. Once freezing begins, as long as liquid and solid are both present, the temperature remains constant until the entire mass has solidified. Allow the computer to continue recording the temperature until the plot has leveled off at a constant temperature. Note that once the cyclohexane has frozen solid, the temperature starts to decrease again.

2.10. 
2.11. 
2.12. When a sufficient amount of datanumber of data points hass been collected, click on the red buttonstop the data collection.  

2.13. Remove the test tube from the ice-water bath and let it warm up to room temperature.

2.14. Save the data.

2.15. Adjust the y-axis limits so the plot fills the page. Title the graph, and then print it.

3. Adjusting and printing the graph.	Comment by Andrew Wilkens: This step is too close to a laboratory exercise. This could be a single step, 2.12, “Print graph with proper axis limits”, or something.

3.1. Save the data.  

3.2. Change the limits on the y-axis, so the plot fills the page, by clicking once on each of the numbers at the ends of the axes, typing in the desired limits, and pressing enter. 

3.2.1. It’s easier to determine the value for Tf° later if the y-axis limits are whole numbers. Choose the maximum values to be slightly greater than the highest temperature or time recorded, and choose a temperature minimum slightly lower than the lowest temperature. The minimum time recorded should be 0 sec.

3.3. Pull down the Options menu and select Graph Options. Be sure that a check mark appears in the box next to Connect Points, and type in an appropriate title for the graph in the box under Title. 

3.4. Pull down the File menu and choose Print Graph.

4. Preparing a Ssolution of the uUnknown Ccompound.

4.1. Accurately weigh 0.14 g of the solid unknown material onto a piece of weighing paper.  	Comment by Andrew Wilkens: Is this just an empirically derived value, or is there a specific reason to choose such a value?	Comment by Information Technology Services: I believe this value is empirically derived. This amounts dissolves relatively easily in 12 mL of cyclohexane but is also sufficient to produce a measurable different in the freezing point.

4.2. Check to be sure the cyclohexane contained in the test tube has melted. 	Comment by Andrew Wilkens: Is it imperative to use the same batch of cyclohexane, or could you also use a fresh aliquot?

4.3. Remove the stopper from the test tube and carefully add the unknown solid to the cyclohexane, while avoiding the loss of any compound adhering to the sides of the test tube or stopper. 	Comment by Information Technology Services: You could use a new aliquot, but the volume would have to be exactly the same.  Also, this would needlessly generate extra hazardous waste.

4.4. Replace the stopper and re-weigh the paper to account for any crystals that remain on it.  

4.5. Stir the solution in order to completely dissolve the solid. It is important that no crystals remain. 

4.6. Make a new ice-water bath.

5. Preparing the computer for the second data collection.	Comment by Andrew Wilkens: Similar comment to Step 3.

5.1. Pull down the Experiment menu and select Store Latest Run.  

5.2. Under the Data menu, choose Hide Data Set, followed by Run 1.

5.3. Click once on the number at the end of the x-axis, type in 800 and press enter.  

5.4. Click once on the number at the bottom of the y-axis, type 0 and press enter, then click on the upper limit, type 40 and press enter.

6. Measuring the Ffreezing Ppoint of a solution of the Uunknown Ccompound dissolved in cyclohexane.

6.1. Prepare the computer to collect a second set of data.

6.2. Click on the green buttonStart the data collection.  

6.3. Move the test tube that contains the solution into the ice-water bath.

6.4. Immediately begin stirring the solution continuously and at a constant rate.

6.5. The temperature does not remain entirely constant as the solution freezes. The freezing point of the solution is the point at which it first begins to freeze and is indicated graphically by a change in the slope of the temperature-time curve. Collect the data for 300-500 sec in order to clearly see this clearlythe change in slope that occurs as the solution freezes.	Comment by Andrew Wilkens: This information would work better in the Principles.

6.6. Click on the red button to stopStop the data collection.

6.7. Save the data, adjust the limits of the y-axis, title the graph, and print it.

6.8. Do not throw any cyclohexane or unknown compound down the sink. Pour the liquid mixture into the “Laboratory Waste” jar. Rinse the test tube and temperature probe with acetone to remove the last traces of any crystals, pouring the rinses in the waste jar.

Results:

The mass of cyclohexane that was dispensed can be calculated. The density of cyclohexane is 0.779 g/mL.  




The values for Tf° and Tf can be determined from the plots.

The molar mass, and thus the molecular weight, of the unknown compound can also be calculated. For cyclohexane, Kf = 20.2 degkg/mole of solute.  







molar mass = ? g/mol
molecular weight = ? amu

The molecular weights of the possible compounds are:

· 154.21 amu for Biphenyl			
· 191.46 amu for 2-Bromochlorobenzene	
· 128.17 amu for Naphthalene			
· 178.23 amu for Anthracene			
· 235.90 amu for 1,4-Dibromobenzene		 

The value determined experimentally for the molecular weight of the unknown compound is closest to the literature value for naphthalene.  

The percent error can be calculated.







& error = ? %

Applications:	Comment by Andrew Wilkens: These are great applications. What visuals (e.g., two beakers of water at 0 C, with and without salt,) can your lab provide on the filming day? 

Perhaps the most visible application of the phenomenon of freezing-point depression occurs during the winter months, when roads and sidewalks become icy, and salt is used to treat the slippery surfaces (Figure 2). When the salt mixes with the ice, the freezing point of the water is depressed so the ice melts at a lower temperature. Because the degree of the freezing point depression is dependent on the number of particles in solution, salts that release three ions per formula unit, such as calcium chloride (CaCl2), are often utilized for this purpose. Ice cream makers also make use of the freezing-point depression that occurs when salt and ice are mixed. The freezing point of cream is well below 0 °C, especially when it is combined with sugar and other ingredients used to make ice cream.  For this reason, ice and rock salt are combined in the outer container of an ice cream maker in order to achieve a temperature low enough to freeze the mixture enclosed in the inner container.	Comment by Information Technology Services: We can add sodium chloride to a mixture of ice and water and see the temperature decrease.  We can add calcium chloride to an ice/water mixture and see the temperature drops even lower than with sodium chloride.

Chemists exploit the phenomenon of freezing-point depression in the analysis of solid organic compounds. The purity of a solid product from a chemical synthesis is often determined by measuring the melting point (theoretically, the same as the freezing point) of the material. If an impurity is present in the compound, the observed melting point is lower than expected. This occurs because, as the solid starts to melt, the impurity acts as a solute that is dissolved in the liquid form of the compound; thus, the melting, or freezing, point of the compound is depressed.

The pharmaceutical industry uses large amounts of organic solvents for reactions that lead to the synthesis of therapeutic agents. These solvents create substantial volumes of liquid waste that are hazardous to the environment. Occasionally, it is possible to take advantage of the freezing-point depression phenomenon to eliminate the need for a solvent in a synthesis. When solid reactants involved in a reaction are crushed together, the melting (or freezing) points of the two compounds are lowered. If the two compounds each have a very low melting point, the pair actually become liquids at room temperature when they are ground together, which allows the molecules to interact with each other so the reaction can occur. These solvent-free processes are an example of “green” chemistry, which refers to chemical procedures that reduce or eliminate the use and generation of hazardous substances.

Legend:

Figure 1: Figure 1a is a plot of temperature as a function of time for the determination of Tf° for the pure solvent. Figure 1b is a plot of temperature as a function of time for the determination of Tf for the solution.

Figure 2: A small vehicle used to snowplow sidewalks. A salt spreader is attached on the back to help melt ice.
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